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Lab Exercise 1.1 – Getting Connected 
 

At the end of this lab exercise, Participants will be able to: 

• Set the IP Address on both their Computer and DataMan Reader 

• Connect to the DataMan reader 
 
The Participant will utilize the following DataMan Functions to successfully complete this 
exercise: 

• Setup Tool 

• Connect to Reader 

 
Set a Static IP Address on your computer. 
 

Follow the steps below to complete the lab exercise:  

1. Open the Network and Sharing Center. 
 

 
 

2. Select Change adapter settings from the right-hand menu. 
 

 
 

 The Network Connections display. 
 

 
 

3. Select the Ethernet adapter. 

 NOTE: If you have a VPN connection make sure that you do not select that adapter. 
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4. Right click and select Properties from the list. 
 

 
 

  The Ethernet Properties display. 
 

 
 

5. Click the Internet Protocol Version 4 (TCP/IPv4) link and click the Properties 

 button.  
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6. Click the Use the following IP address button and enter the information below and 

click the OK  button.  
 

   
 

7. Click the Close  button to close the Ethernet Properties dialog box. 

 
Launch the DataMan Setup Tool 

 

Follow the steps below to complete the lab exercise:  

1. Click the DataMan  icon on your desktop to launch the DataMan software.  
 The DataMan Setup Tool launches showing all the readers on the network.  

 

 
 

2. Select your DataMan Fixed Mount Reader from the list to highlight. 

 
NOTE: This exercise uses the DM474 – notice that the Status is Misconfigured. 
This is because the reader is in DHCP mode and you have set a static IP Address 
on your laptop.  

 

 



                              
 

DataMan Standard   Section 1 | Lab Exercise  

    

Page 4 

 

3. Click the Repair & Support tab on the left-hand menu (with your Reader 
highlighted). 

 

 
 

 The Network Settings display on the right-hand side of the screen. 

4. Click the Use Static IP Address radio button and the Copy PC Network Settings 

 button and select [Intel(R) Ethernet Connection (4) 1219-LM] from 
the drop-down list.    

 
This auto-populates the IP Address, and Subnet Mask to match your computer’s IP 
address.  

 

 
 

 

5. Change the last # in the IP Address to 201 and click the Apply  

button. 
 

The network settings are updating. 
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6. Click the Close  button.  

 
The IP Address has been assigned to the Reader and the Status is now 
Discovered.  

 

 
 

 
 

7. Return to the Connect tab  
 

 
 

8. With your Reader highlighted click the Connect button at the bottom of the screen.  
 

 
 

 You are now connected to the reader.  
 

 
 

 And, have entered the DataMan Setup Tool in the Optimize Image step.  
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Lab Exercise 2.1 – Optimize Image 
 

At the end of this lab exercise, Participants will be able to: 

• Optimize the reader settings using the Tune button 

• Utilize the Test button 
 
The Participant will utilize the following DataMan Functions to successfully complete this 
exercise: 

• Tune button 

• Test button 
 
 

Tuning 
 

Follow the steps below to complete the lab exercise:  

1. Click the Reset Configuration button from the System Menu. 
 

 
 

 The Configuration reset dialog box displays. 
 

 
 

 

2. Click the OK  button to continue. 

3. Navigate to the Optimize Image step.  
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4. Click the Live  button to enable Live Mode and place the Power Grid demo plate 
in the FOV.  

 

 
 

 

5. Click the Live  button to disable Live Mode.  

6. Press the Tune button on the top of the Reader for less than 1 second. 

 
NOTE: You have discovered a hidden feature – Tapping the Tune button toggles 
the aimer lights. Press the Tune button until the aimer is ON. 

7. Now press and hold the Tune button on top of the Reader for approximately 5 
seconds until it initiates the tune sequence. You will notice the LEDs flash.   

  NOTE: The Reader will go through the following process: 

• Optimize focus 

• Optimize brightness 

• Cycle exposure values 

• Plot points on the graph 
o Dots above the horizontal line are good reads 
o More dots higher on the graph is the sign of a robust algorithm! 

• When completed it will display and automatically apply the optimum 
settings 

 

8. Click the Trigger  button to show that it can read the good code.  
9. Click the Test button and cover all but one of the codes on the plate to show 

that the Power Grid algorithm can easily read all the damaged codes.  
1. Quiet Zone Violation 
2. Finder Pattern Damage 
3. Clocking Pattern Damage 
4. Damage All 

 

 



                              
 

DataMan Standard   Section 2 | Lab Exercise  

    

Page 9 

 

 

10. Click the Code Details step and set the number of codes (Application Steps  
Code Details  Number of Codes) to 5 hit the <Enter> key. 

 

 
 

 

11. Set the number of Data Matrix codes to 5 and click the Trigger  button to read 
all the codes on the plate at the same time.   

 

 
 

All 5 Data Matrix codes are read: 
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Advanced Tuning Settings: 
 

1. Click the Reset Configuration button from the System menu. 
 

 
 

 The Configuration reset dialog box displays.  
 

 
 

 

2. Click the OK  button to close the dialog box.  
 

Notice that the Tune Code After Tuning checkbox is checked by default.  
 

 
 

NOTE: This feature trains on code properties such as: 

• Symbology Type 

• Pixels per Module 

• 1D Orientation  

• 2D Grid Size  
Codes with properties that differ from the trained properties may not read 
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3. Tune the reader on the Ace of Hearts.  Do this by clicking the Tune button. 
 

 
 

 

4. Turn the card 90° and click the Trigger  button.  
 Notice that the code did not read because it is trained on a specific orientation. 
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5. Click the Code Details step and notice that other symbologies are greyed out 
because the reader is trained on Code 128. 

 

 
 

6. Turn the card back to its original orientation. 

7. Move the card close to and further away from the reader while triggering. 

 
NOTE: At some point the reader will not read the code because the ppm will be 
larger than the trained properties.  

8. Click the Disable Untrained Symbologies checkbox to uncheck the box. All 
codes are now active.   

 

 
 

 Can you read a Data Matrix code now?   
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9. Click the Automatic Symbology Detection button.  
 

 
 

 The Found Symbologies dialog displays.  
 

 
 

10. Hold the Ace of Clubs, Ace of Hearts and Queen of Hearts in front of the reader to 
auto recognize the symbology on each card.  

 The reader recognizes the symbology on each card and adds them to the Found 
Symbologies list.  

 

 
 

 

11.  Click the OK  button.  
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 The Warning box displays.  
 

 
 

 

12. Click the Yes  button to continue.  

 The three Found Symbologies are now selected  
 

 
 

13. Click the Untrain Code button. 
 

 
 

 Can you read a 1D code in any orientation now?   
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Lab Exercise 2.2 – Code Details 
 

At the end of this lab exercise, Participants will be able to: 

• Filter specific barcodes by symbology type and string length 

• Utilize extended mode for challenging codes 

• Read 2 codes within the FOV within the same trigger cycle 
 
The Participant will utilize the following DataMan Functions to successfully complete this 
exercise: 

• Setup Tool 

• DataMan Application Steps  
o Code Details 

 
Follow the steps below to complete the lab exercise:  

1. Connect your DataMan reader to the DataMan Setup Tool.  

2. Click the Reset Configuration button from the System Menu. 
 

 
 

 The Configuration reset dialog box displays. 
 

 
 

 

3. Click the OK  button to continue. 
4. Navigate to the Application Details step and set the Trigger Type to Single 

(external).  
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5. Navigate to the Optimize Image step and click the down arrow on the Tune button 
to Optimize Brightness and Optimize Focus using the Ace of Hearts.  

 

 
 

6. Navigate to the Code Details step – check the Code 128 checkbox.  
 

    

 
 

 

7. Click the Trigger  button to read the Ace of Hearts. Leave the code enabled.  
 

 



                              
 

DataMan Standard   Section 2 | Lab Exercise  

    

Page 17 

 

8. Navigate to the Settings Menu, click the down arrow of the Symbology Settings and 
select Code 128.  

 

 
 

 The Code 128 Properties display.  
   

    
 

9. Uncheck the Any checkbox and set the Code Size Max to 9. 
 

 
 

  
NOTE: The reader will not read any codes with a data string length that is greater 
than 9 characters. 

10. Read the Ace of Hearts (ACEHEARTS = 9 characters) and the King of Hearts 
(KINGHEARTS = 10 characters). 
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  Confirm that the Ace of Hearts = READ and the King of Hearts = NO READ.  
 

    

 
 

11. Change the Code Size Max to 10 and confirm the King of Hearts can now be read. 
 

   
 

12. Navigate to the Code Details step – check the Data Matrix checkbox.  
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13. Place the Data Matrix code and the Ace of Hearts in the FOV. 

14. Click the Advanced tab and set the following: 

• Number of Codes = 2 

• Data Matrix – Max Number of Codes = 1 

• 1D / Stacked / Postal – Max Number of Codes = 1  
 

 
 

 

15. Click the Trigger  button. 

 Both codes are read. 
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16. Try to read only the Ace of Hearts or the Data Matrix code. 

 Are you able to read only one code?  
 

 
 

   
 

 

17. Check the Allow Partial Results checkbox and click the Trigger  button to read 
the Ace of Hearts.  

 

 
 

 The reader will read the Ace of Hearts. 
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Lab Exercise 3.1 – Application Details 
 

At the end of this lab exercise, Participants will be able to: 

• Determine which Trigger Mode to use to get the best read result 
 
The Participant will utilize the following DataMan Functions to successfully complete this 
exercise 

• Trigger Modes 
 
 

Trigger Modes  
 

Follow the steps below to complete the lab exercise:  

1. Place the Ace of Hearts card in the field of view.  

 
NOTE: If you do not have a DataMan deck of cards, use the images printed in the 
Resources section of the training manual.  

2. Click the down arrow on the Tune button to open the Tune menu.  
 

 
 

3. Click on Optimize Brightness and Optimize Focus from the Tune menu.   
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 The Ace of Hearts displays in the Field of View (FOV).  
 

 
 

4. Click the Application Details step. 

 The Basic Application Details display. 
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Single (external) Trigger Type 
 

1. Set the Trigger Type to Single (external).  
 

2. Click the Trigger  button and notice that it only acquires one image per trigger.  

3. Set the Delay Type to Time and set the Start Delay Time (ms) to 1000ms. 
 

 
 

 

4. Click the Trigger  button and notice that it now has a delay of 1 second before 
acquiring the image.  

5. Set the Start Delay Time (ms) back to 0. 

 
Continuous (external) Trigger Type 
 

1. Set the Trigger Type to Continuous (external).  

2. Remove the card from the FOV. 

3. Hold down the trigger button and move a code through the FOV. Notice that once 
the reader reads the code, the string is output, and the trigger cycle ends.  

4. Set the Interval Time to 100,000µs.  Notice how much faster the reader acquires 
between images. 

5. Set the Interval Time to 0µs. Notice that the reader updates to the max frame 
rate of the reader. 

6. 
With this interval, trigger the reader and attempt to read the code. If the code is 
not read it is because the decode time is longer than the entered µs.  

7. Change the Interval Time back to 100,000µs and note the reader reads the 
code. 

 
Burst (external) Trigger Type  
 

1. Set the Trigger Type to Burst (external).  

2. Remove the code from the FOV. 

3. Set the Interval time to 1,000,000 µs. 

4. Trigger the reader and notice it acquires 2 burst images with the default settings. 

  

NOTE: All images in a burst sequence can be viewed in the Results Display menu 
by enabling Transfer All Images from the Advanced tab of the Optimize Image 
application step. Optimize Image  Display Image Settings  Image Transfer 
Settings  Transfer All Images. 



                              
 

DataMan Standard   Section 3 | Lab Exercise  

    

Page 24 

 

5. Return to the Application Details step, and set the Burst Length to 9, and the 
Interval time to 500,000 µs. 

6. Click the trigger button and pass the card through the FOV. 

 NOTE: The images in a burst sequence can be viewed in the Results History 
window by expanding the + sign. 

 
Manual (button) Trigger Type  
 

1. Set the Trigger Type to Manual (button).  

2. Hold down the trigger button until it reads the Ace of Hearts code. 

3. Click the Optimize Image step and click the Automatic Exposure radio button in 
the Tune menu.  

    
 

4. Remove the card from the FOV and move your hand closer to and further away 
from the light while holding the trigger – notice the auto exposure taking place.  

 

 
Presentation (internal) Trigger Type  
 

1. Return to the Application Details step. 

2. Set the Trigger Type to Presentation (internal).  

3. Place the card in the FOV – notice that it reads continuously. 
 

 
Self (internal) Trigger Type  
 

1. Set the Trigger Type to Self (internal).  

2. Set the Interval time to 40,000 µs. 
 
 

3. In the Image Panel, click the Enable/disable image transfer  button to 
disable the image transfer.   
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4. On the Code Details Application Step, uncheck the Data Matrix check-box to 
disable the symbology.  The reader is now reading even faster! 

 

    
 

Bonus: 
Never Read Same Code Twice 

Perform with your Reader still in Self (internal) trigger mode with your card in the FOV. 
 

 
 
Enable the Never Read Same Code Twice box 

√ Try to read the same code twice and notice that it will not do so unless another code 

is read in between (Read the Ace of Hearts and then the King of Hearts) 

√ Place another card in the FOV and notice the read 

√ Place the Ace of Hearts back and notice that it will read it again. 

Disable the Never Read Same Code Twice box 

√ Change the Delay Mode to After First Read 

√ Set the Re-Read Delay to 1000 ms 

√ Leave the code in the FOV and notice that the reader outputs every 1 second 

√ Change the Delay Mode to After Last Read  

√ Leave the code in the FOV and notice that it will only output once 

√ The code must be removed from the FOV for 1 second before it will output again 
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Lab Exercise 4.1  – Data Validation    
 

At the end of this lab exercise, Participants will be able to: 

• Utilize the Data Validation functionality  

• Calculate the mil size of a barcode and the maximum FOV for that code size 

• Explore the Process Control Metrics available in the Setup Tool  
 
The Participant will utilize the following DataMan Functions to successfully complete this 
exercise: 

• Setup Tool 

• DataMan Validation 

• Process Control Metrics 

 
Data Validation – Match String Validation  

 

Follow the steps below to complete the lab exercise:  

1. Connect your DataMan reader to the DataMan Setup Tool.  

2. Click the Reset Configuration button from the System Menu. 
 

 
 

 The Configuration reset dialog box displays. 
 

 
 

 

3. Click the OK  button to continue. 
4. Navigate to the Optimize Image step and click the down arrow on the Tune button 

to Optimize Brightness and Optimize Focus using the Ace of Hearts.  
 

5. Click the Trigger  button to ensure you can read the Ace of Hearts.  

6. Navigate to the Settings Menu and select Data Validation. 
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 The Data Validation page displays. 
 

 
 

7. On the 1D/Stacked/Postal tab select Match String Validation.  

 
NOTE: Match String Validation enables you to specify an exact string to match 
against the string encoded by the symbol. Only symbols containing a string that 
matches the specified string will generate a Pass result.  

 The Match String field displays.  

8. Enter ACEHEARTS in the Match String field. 
 

 
 

 

9. Click the Trigger  button and review the results. 
 

NOTE: Click the Plus sign   to expand the results. 
 

    
 

10. Enter ACECLUBS in the Match String field.  
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11. Click the Trigger  button and review the results. 
 

    
 

12. Change the card in the FOV to the King of Hearts.  
 

13. Click the Trigger  button and review the results.  
 

   
 

14. Change the card in the FOV back to the Ace of Hearts.  

15. Enter aCEHEARTS in the Match String field.  
 

 
 

 

16. Click the Trigger  button and review the results.  
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Is it valid?    
 

   
 

 

NOTE: aCEHEARTS is not a valid match. The Match String field is case sensitive.  

 
 

Data Validation – Pattern-Matching Validation 
 

17. On the 1D/Stacked/Postal tab select Pattern-Matching Validation.  

 
NOTE: Pattern-Matching Validation enables a user to input a specific string of 
characters to confirm if they are present in the data string.  

 The Pattern field displays. 

18. Enter HEARTS in the pattern field.  

 
 

 

19. Click the Trigger  button and review the results.  
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20. Change the card in the FOV to the King of Hearts.  
 

21. Click the Trigger  button and review the results.  
 

  
 

 
NOTE: Both codes are valid because HEARTS is a subset of the string contained in 
both strings.  

22. Change the card in the FOV to the 4 of Diamonds. 
 

23. Click the Trigger  button and review the results.  
 

 
 

 
NOTE: The code fails because the pattern (Diamonds) does not match the pattern 
we were searching for (Hearts).  
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Read Setups 
 
Follow the steps below to complete the lab exercise:  

1. Connect your DataMan reader to the DataMan Setup Tool.  

2. Click the Reset Configuration button from the System Menu. 
 

 
 

 The Configuration reset dialog box displays. 
 

 
 

 

3. Click the OK  button to continue. 
4. Navigate to the Application Details step and set the Trigger Type to Single 

(external). 
5. Navigate to the Optimize Image step and click the down arrow on the Tune button 

to Optimize Brightness and Optimize Focus using the Ace of Hearts.  
 

6. Click the Trigger  button to ensure you can read the Ace of Hearts.  

7. Navigate to the Settings Menu and select Read Setups. 
 

 
 

8. Click the Add Setup button to add a second read setup. 
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 The Add Setup dialog displays. 

 
NOTE: You have the option to use the default values or copy values from the current 
setup.  

 

 
 

 

9. Select the Copy Values from setup and click the OK  button. 
10. Change the Name of the setups – click into the Setup0 field and rename to 1D and 

click into the Setup1 field and rename to 2D. 
 

 
 

11. Return to the Settings tab and select 2D from the Active Read Setup drop-down 
list. 

 

 
 

12. Hold the Data Matrix code about 3 – 4 inches from the lens of the reader and click 

the Trigger  button. 
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 The reader does not read the code – it is too close to the lens. 

 
 

13. While in the 2D Active Setup, with the Data Matrix code 3 – 4 inches in front of the 
reader Tune the code.   

 NOTE: The settings required to read the code at this distance will automatically be 
applied to the setup. 

 

14. When it is done, click the Last Successful Decode radio button as the Starting 
Setup. 

 
 

15. Trigger the reader to confirm that the reader can now read both the 1D code at 
desk level and the 2D code close to the lens. 

 NOTE: When you trigger the reader, if it can get a read, it does. If No Read, (you 
switched codes) it will trigger again utilizing the second setup.  
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16. Navigate to the Application Details step and change the Trigger Type to Self 
(internal). 

 
 

17. Set the Interval (µs) field to 500,000 µs. 
 

 
 

 The reader will now cycle through both reads continually.  
 

 

Calculate Mil Size – *If time allows* 
 

Follow the steps below to complete the lab exercise:  
 

1. Connect your DataMan reader to the DataMan Setup Tool.  

2. Adjust the mounting of the reader so that the horizontal FOV is the exact width of 
this paper. 

 

3. Click the Live  button to place the reader into Live View, move the reader until 
the barcode below is in the center of the FOV. 

4. Navigate to the Code Details step and confirm the 1D symbologies are enabled. 
 

 
 

 

5. Return to the Optimize Image step and click the Trigger  button to read the 
barcode below.  
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6. Navigate to the Code Details step and confirm the 1D symbologies are enabled. 
 

 
 

7. Note the PPM value reported in the results display. 

 NOTE: This is the number of pixels in the minimum module.  

 
8. Calculate the mil size of the bar code.  

a. Pixel Width = 8.5 (in) / Horizontal Pixels 
b. Mil Size = Pixel Width *PPM value = pixels per narrow bar* 1000 

a. 8.5 (in) / 1280 pixels = .00664 *3.15 ppm = 0.0209* 1000 = 21mil 
 NOTE: Recommended Minimum mil sizes per code: 

1D Linear – 1.1 PPM 
2D Printed – 2.5 PPM 
2D Direct Part Mark – 4 PPM 

9. Calculate the Maximum FOV with the 21 mil code for the DataMan 262. 
a. ((Mil Size / 1000) / minimum recommended PPM) * Reader Pixels 
b. ((21 / 1000) / 1.0) * 1280 = 26.88 in Max FOV 

 

7.20 PPM 
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Lab Exercise 4.2 – Format Data  
 

At the end of this lab exercise, Participants will be able to: 

• Format the output data and No Read strings using a DataMan 8600 USB handheld 
 
The Participant will utilize the following DataMan Functions to successfully complete this 
exercise: 

• Setup Tool 

 
Follow the steps below to complete the lab exercise:  

1. Connect your DataMan handheld reader to the DataMan Setup Tool.  

2. Open a blank Excel spreadsheet on your computer and highlight a cell.  

3. Using your handheld reader, scan the Ace of Hearts barcode.  

 Was anything entered in the highlighted cell?  
 

 
 

 

NOTE: The answer is No, if your reader is in USB Com mode. It may need to be 
converted to USB Keyboard mode. When in USB Keyboard mode, the reader will 
emulate a keyboard input, typing the decoded data string wherever the curser is 
located on the screen.  

4. Scan the USB Keyboard code below. 
 

 
 

 
NOTE: The code above is used for corded readers only. If you are communicating 
through a Base Station via USB, there is a separate code to Enable the USB 
Keyboard for the base station shown below.  
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5. Now, highlight a cell in the Excel spreadsheet and scan the Ace of Hearts several 
times.  

 Was anything entered in the cells this time? 
 

 
 

 
NOTE: The answer is Yes. The cells between scans are skipped because the default 
data formatting includes both a <CR> and <LF> at the end of the string which Excel 
interprets as 2 <Return> commands.  

 

 
What if we do not want the extra space? 
If your reader is in USB Keyboard it will need to be converted to USB-COM mode. 

 

6. In the Repair & Support tab of the DataMan Setup Tool, select the DM8600 reader 

and click the Convert to USB-COM  button, or, you can scan the 
USB-COM code below. 

 

 
 

7. When your reader is back in USB-COM mode, you can select it from the Connect 
window and click the Connect button. 

 

 
 

 
 

8. Navigate to the Format Data application step and check the Universal Standard 
box under Basic Formatting  
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9. Click on the Standard hyperlink. 

 The Universal menu displays. 
 

 
 

 

9. Select <Full string> under the Data General tab and click the Add  
button. 

10. Type \r in the Terminating Text field.  

 NOTE: The \r translates only to <CR>. 

11. Save the settings to the reader by clicking the Save Settings button in the 
Application Steps. 

 

 
 

 

12. The Configuration dialog box displays. Click the OK  button to continue. 
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13. Click the Round X on the DM8600 pane to disconnect the reader. 
 

 
 

14. Scan the USB Keyboard code in Step #4.  

15. Place your curser in a cell in the Excel spreadsheet and scan the Ace of Hearts bar 
code a few times.  

 Notice that it is no longer skipping a cell.  
 

 
 

16. Trigger the reader without reading a barcode to generate a No Read and notice the 
output sequence.  

 It is skipping a cell again. 
 

 
 

 
NOTE: This is because the data formatting applies to a No Read also because we 
created it in the Universal tab. So, the reader is sending a blank string + <CR>. 

 What if we don’t want to skip a cell during a No Read? 

17. In the Repair & Support tab of the DataMan Setup Tool, select the DM8600 reader 

and click the Convert to USB-COM  button, or, you can scan the 
USB-COM code below. 

 

 
 

18. When your reader is back in USB-COM mode, you can select it from the Connect 
window and click the Connect button. 
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19. Navigate to the Format Data application step and uncheck the Universal Standard 
box and check the 1D / Stacked / Postal box under Basic Formatting  

 

 
 

 
 

20. Click on the Standard hyperlink. 

 The 1D / Stacked / Postal menu displays. 
 

 
 

 

21. Select <Full string> under the Data General tab and click the Add  
button. 

22. Type Start_ in the Leading Text field and _End\r in the Terminating Text field.  
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23. Save the settings to the reader by clicking the Save Settings button in the 
Application Steps. 

 

 
 

 

24. The Configuration dialog box displays. Click the OK  button to continue. 
 

 
 

25. Click the Round X on the DM8600 pane to disconnect the reader. 
 

 
 

26. Scan the USB Keyboard code in Step #4.  

27. Place your curser in a cell in the Excel spreadsheet and scan the Ace of Hearts bar 
code a few times and also create some No Reads.  

 

 
 

  
Notice the new data formatting and that it is no longer skipping a cell for No Reads.  
But, what if we want to define a  specific No Read string? 

28. Connect to the reader using the process in step #6. 

29. Define a No Read string 

30. Navigate to the Inputs / Outputs application step, click the Advanced tab, open 
the No Read Output String menu and enter NoRead\r in the No Read Output 
String field.    
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31. Save the settings to the reader by clicking the Save Settings button in the 
Application Steps. 

 

 
 

 

32. The Configuration dialog box displays. Click the OK  button to continue. 
 

 
 

33. Click the Round X on the DM8600 pane to disconnect the reader. 
 

 
 

34. Scan the USB Keyboard code in Step #4.  

35. Place your curser in a cell in the Excel spreadsheet and scan the Ace of Hearts bar 
code a few times and also create some No Reads.  
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Scripting Lab #1 
 

Multi Code Reading Demo  
 

The challenge is to read codes that are close together on a box, making sure there are no 
double reads and all the codes are output in one string.  
 

The solution is a script that allows the user to read 3 codes but holds the output until all 3 
codes have been read. Then it outputs all 3 codes at once. If the same code reads twice 
the script will cause a data validation failure action and the user can continue scanning until 
3 unique codes are read.  
 
The Never read the same code twice functionality in the Setup tool only applies to multi-
code reading within a single trigger. To ensure the same code is not read on separate 
triggers a script is needed.  
 
Scan Configuration Codes: 
 

Here is an example to simulate scanning a box: 
 
Reset to Factory Defaults: 
 
 
 
Custom RPC: 
 
 
 
 
 
 
Sample Codes: 
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Lab Exercise 5.1 – Inputs / Outputs  
 

At the end of this lab exercise, Participants will be able to: 

• Disable the TRIG Button and TUNE Button on the reader 

• Disable the beeper on a good read 
 
The Participant will utilize the following DataMan Functions to successfully complete this 
exercise: 

• TRIG Button tab 

• TUNE Button tab  

• Outputs tab  

 
Inputs and Outputs  

 

Follow the steps below to complete the lab exercise:  

1. Connect your DataMan reader to the DataMan Setup Tool via Ethernet.  

2. Click the Reset Configuration button from the System Menu. 
 

 
 

 

3. The Configuration reset dialog box displays. Click the OK  button to 
continue. 

 

 
 

4. Click the Tune button on the Optimize Image application step to Tune the reader on 
the Ace of Hearts.  

 

 



                              
 

DataMan Standard   Section 5 | Lab Exercise  

    

Page 48 

 

4. Click the Tune button on the Optimize Image application step to Tune the reader on 
the Ace of Hearts.  

5. Navigate to the Inputs/Outputs application step.  
 

 
 

 The Inputs/Outputs page displays.  
 

 
 

6. Click the TRIG Button tab. 

 The TRIG Button controls display.  
 

 
 

7. Check the Disable Reader Button checkbox as shown above.  

8. Next, click the TUNE Button tab.  
 

 
 

9. Check the Disable Reader Button checkbox as shown above.  

10. Click the TUNE button on your reader.  
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11. Click the TRIG Button on your reader. 

 Did anything happen? 

12. Trigger your reader multiple times to get both good and bad reads on the Ace of 
Hearts.  Notice the beeping sound on the good reads. 

13. Click the Outputs tab.   
 

 
 

 Notice the Enable Beeper on Good Read checkbox is checked.  
 

 
 

14. Uncheck the Enable Beeper on Good Read checkbox.  
 

 
 

15. Trigger your reader multiple times to get both good and bad reads on the Ace of 
Hearts.  Notice, there is now no beeping sound for any of the reads – good or bad.   
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Master / Slave  
 

If the DataMan readers in the classroom are on the network the Instructor will tell you 
which reader you should select as your second reader.  Each class member will have the 
opportunity for their reader to be the Master and the Slave in the grouping.  
 
If you are using a DataMan 470 series reader it will require a feature key to complete this 
activity. 
 
Follow the steps below to complete the lab exercise: 
 

1. Connect your DataMan reader to the DataMan Setup Tool.  

2. Click the Reset Configuration button from the System Menu. 
 

3. The Configuration reset dialog box displays. Click the OK  button to 
continue. 

4. Connect to a second reader on the network.  

5. Click the tab that corresponds to your reader, and click the Settings tab.  
 

 
 

6. Click the Master/Slave button on the Settings tab. 
 

 
 

 The Master/Slave settings display.  
 

 
 

7. Click the Edit Group button.  
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 The Select Group to Open dialog displays.  
 

 
 

 The Edit Groups tab displays. 
 

 
 

8. Click on the folder with your reader’s name. Confirm that the Grouping tab is 
selected. 

9. Rename the folder to Line1.  
 

 
 

10. Click the Refresh Grouping Info button.  

 This will update the PC. 
 

 
 
 

11. Click the Apply and Save Grouping to Devices button.  
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 This will update the Reader. 
 

 
 

12. Confirm the Grouping Tab and Group Name have updated to Line1. 
 

 
 

13. Click the Grouping: Line 1 tab. 
 

 
 

14. Highlight your second reader on the Discovered Devices and click the Add 

Discovered Device(s)  button to add it to the group.  
 NOTE: You can also drag and drop the reader into the group.  

 The second reader is added to the group folder.  
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15. Select your reader and click the Set Master Device button. 
 

 
16. Click the Refresh Grouping Info button.  

 This will update the PC. 

17. Click the Apply and Save Grouping to Devices button.  

 This will update the Reader and eliminate error messages.  

18. Click on the reader tab belonging to your DataMan reader.  

19. Place the Ace of Hearts under your reader, and the Queen of Hearts under your 
second reader. 

 

20. Click the Trigger  button.  

 The LEDs on both readers will flash.  

21. Expand the Decode Results, verify the Master Reader is the collector of the 
decoded information.  

 NOTE: The code with the image graphic  is from the Master Reader.  
 

 
22. Click the second reader’s tab. 

 

23. Click the Trigger  button.  
 

The LEDs on both readers will flash.  

24. Review the Results History of your second reader.  
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25. Click your Master reader’s tab and review the Results History.  
 

 
 

26. The Configured Settings on both the Master and Slave Readers must be the same.  

 

a. Code Details step 
a. 1D = Code 128 checked 
b. How many codes = 2 
c. Partial Results = Yes 
d. Codes = 2 1D/Stacked/Postal 

 

b. Application Details  
a. Trigger = Continuous 
b. Decode Settings  

i. Never Read Same Code Twice = checked 
ii. Code Re-Read Delay = 300 

 

27. Click the Trigger  button. 

 The LEDs on both readers will flash.  

28. Review the results for both readers.  
 
 

Remove a Reader from a Group 
 

1. Click on the Grouping: Line1 tab.  

2. Click on the Edit Groups tab. 

3. Click on the Reader to be removed from the group. 

4. Click on the Edit Groups tab and click the Remove Node button. 
 

 
 

6. Click the Refresh Grouping Info button.  

7. Click the Apply and Save Grouping to Devices button.  
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Lab Exercise 6.1 – Deployment  
 

At the end of this lab exercise, Participants will be able to: 

• Utilize the utilities available in the DataMan Setup Tool to finish deploying the 
application 

 

The Participant will utilize the following DataMan Functions to successfully complete this 
exercise: 

• Code Quality Metrics  

• RTM Lean 

• Backup/Restore Configurations 

• Update Firmware 

 
Code Quality Metrics – 1D Codes  

 

Follow the steps below to complete the lab exercise:  

1. Connect your DataMan reader to the DataMan Setup Tool.  

2. Navigate to the Optimize Image application and uncheck the Train Code After 
Tuning checkbox.  

 

 
 

3. Tune the reader on the Ace of Hearts with the barcode horizontal in the image.  
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4. Manually adjust the settings using the settings below the image.  

 
NOTE: Your settings will likely not match those in the screenshot below. Adjust your 
settings to create a good contrast between dark and light. 

 

 
 

5. Trigger the reader to ensure that it can read the code. 
 

 
 

6. Open the View menu and click the Code Quality button.  
 

 
 

 The Code Quality window opens.  
 

 
 

7. Trigger the reader and confirm the Ace of Hearts is read.  

 Note that nothing displays in the Code Quality window. We need to enable this.  
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8. Open the Settings menu and click the Code Quality button.  
 

 
 

 The Code Quality menu displays.  

9. Under the General tab, click the 1D Readability (Cognex) radio button under the 
1D Barcode Metrics options. 

 

 
 

10. Trigger the reader. 

 Review the results in the Code Quality window.  
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11. Open the View menu and click the Image Viewer button.  
 

 
 

 The DataMan Setup Image Viewer pop up window displays. 
 

 
 

 Notice the PPM – it is 4.96, this is within the 3-5 range which is ideal for 1D grading. 

12. Change the card to the King of Hearts and trigger your reader. Review the results in 
the Code Quality window. 
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13. Change the card to the 9 of Clubs and trigger your reader. Review the results in the 
Code Quality window. 

   
 

14. Look at the Scan Integrity grades for each.  Notice how they are different. 

 NOTE: The system assigns grades A-F based on thresholds for each of the 
parameters. However, the customer may not be interested in specific parameters, 
or they may want to adjust the values that define the A-F grade. This is done in the 
1D Barcodes tab in the Code Quality menu by checking the Custom Threshold 
checkbox. 
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Code Quality Metrics – Data Matrix Codes  
 

15. Open the Settings menu and click the Code Quality button.  
 

 
 

 The Code Quality menu displays.  

16. Under the General tab, click the ISO/IEC 15415 radio button under the Data Matrix 
Metrics options. 

 

 
 

17. Trigger the reader using the Good Data Matrix Code printed in the Resources 
section. 

 
 

18. Review the Code Quality results to confirm you get a good grade when reading the 
Data Matrix code. 
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19. Put the Damaged Code in the FOV and trigger your reader. 
 

 
 

 Notice that the Fixed Pattern Damage metric fails. 
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Code Quality Reports 
 

Code Quality works while the system is up and running, so you have a couple of options to 
output the data in real-time. 
 

The first method is to add the grade and code quality values to the output string, so it can 
be monitored by the customer’s system.  
 

Follow the steps below to complete the lab exercise: 
 

1. Open the Settings menu and click the Data Formatting button.  
 

 
 

2. Click the Script-Based Formatting radio button and click into the blue hyperlink. 
 

 
 

  The Scripting Data Formatting page displays. 
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3. Click Insert Snippet  Simple Formatting  Outputting code quality 
parameters.  

 

 
 

 The Snippet script displays.  
 

 
 

4. Place the Good Code in the FOV and trigger your reader.  

 
Notice that the script added the same parameters you see in the Code Quality pane 
(at the bottom of the screen) to the output string: 
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- SC = Symbol Contrast 
- ANU = Axial Non-uniformity 
- PG = Print Growth 
- UEC = Unused Error Correction  
- MOD = Modulation 
- FPD = Fixed Pattern Damage 
- MR = Reflectance Margin 
- GNU = Grid Non-uniformity 
- ExtRef = Extreme Reflectance Grade 

 
NOTE: This is completed with the sample script that we enabled, and as a result it is 
completely customizable.  

 

 
 

 
NOTE: As you can see, you can change the order and labels very easily with no 
programming experience required. The end user simply accepts and outputs and 
parses the data in the system to take action where needed.  
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RTM Lean 
 

Follow the steps below to complete the lab exercise:  

1. Connect your DataMan reader to the DataMan Setup Tool.  

2. Click the Reset Configuration button from the System Menu. 
 

 
 

 The Configuration reset dialog box displays. 
 

 
 

 

3. Click the OK  button to continue. 

4. Open the Settings menu and click the Code Quality button. 
 

 
 

5. Check the Data Matrix Metrics AIM-DPM/ISO/IEC TR29158 and the 1D Barcode 
Metrics ISO/IEC 15416 radio buttons. 
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6. Navigate to the Optimize Image application step and uncheck the Train Code 
After Tuning checkbox. 

 

    
 

7. Navigate to the Application Details application step and set the Timeout[ms] to 
500. 

 

    
 

8. Return to the Optimize Image application step and click the Tune button to Tune 
the reader on the Ace of Hearts. 

 
 

9. Click the down arrow on the Test button and set the Trigger Off [ms] to 500. 
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10. Click the Test button to enable Test Mode. This will simulate an external trigger to 
the reader roughly 2 times per second. 

 

 
 

11. Return to the Home page and Connect to the RTM Lean Network Device. 
 

 
 

 
 

12. The list of available readers displays. Select your reader from the list and click the 

OK  button.  

 
 

 The Collection Configuration page displays.  

 NOTE: You are connected to the DM474 and the RTM Lean Network Device. 
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13. Check all the checkboxes within the Data Collection Settings section and the 

Collection Enabled checkbox, then click the Apply  button. 
 NOTE: If you are already connected to the RTM Lean you may need to click the 

Configuration cog to get to the Collection Configuration page.  
 

 
 

 The Data Collection warning box displays.  
 

 
 

 

14. Click the Yes  button to continue. 
 NOTE: The Real Time Monitoring window within the Setup Tool must remain open 

for data to be collected.  
15. Click the Performance Overview button to enter the Performance Overview page.  

 

 
 

16. Check the Read rate radio button and select the Last hour chart. This will show the 
statistics for the last hour only.  
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17. Trigger the reader on the Ace of Hearts – get a collection of good and bad reads. 
Put your finger or another object over the code so the reader cannot read it to get 
the bad result. 

 

 
 

18. Review the Read rate result graph for the Last hour – notice how the graph dips 
when there is a bad read result. 

 

 
 
 
 
 



                              
 

DataMan Standard   Section 6 | Lab Exercise  

    

Page 70 

 

19. Click the NoRead Image History button to see the no read images that have been 
automatically stored there.  

 

 
 

   
 

 NOTE: The Time Stamp matches the performance chart, so you can correlate the 
performance trend to the specific no-read images.   

20. Click the Code Quality Overview button to view the statistics available to the 
reader.  

 

 
 

 
 

 NOTE: The drop down on the left will allow you to see the statistics that are available 
to the reader. In other words, if you do not have the grading turned on, your device 
does not have a PCM feature key, or you are not running 5.7 (or higher) firmware, 
you will not see anything in the list.   
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21. Change the Plotted Value to Decodability Grade (1D ISO/IEC 15416  Grades  
Decodability.   

 

 
 

21. Place the King of Hearts under the reader and notice to Decodability because of the 
damage inside of the code.  

22. Click the Trigger Performance button.  
 

 
 

23. Select Decode Time for the Plotted values field, and Edge Determination Grade for 
Color plots based on field. 
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 NOTE: If you click on any of the points corresponding to a no-read, then you can see 
a snapshot of the image here as well.  

24. Click the Code Quality button and disable the Data Matrix symbology. 
 

 

 
 

25. Return to Trigger Performance and select Decode Time for the Plotted values field, 
and Symbology for Color plots based on field. 

 

 
 

 
 

 NOTE: If you introduced any high decode times due to no-reads while changing cards 
then you may need to adjust the slide bar at the bottom of the graph to get a more 
granular view. Here you should be able to see how decode times increased when 
we introduced the King of Hearts, because the damage added more time, but then 
decreased when we turned off Data Matrix, as the decoder has less to search for. 
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Buffering and Transfer 
 

In this lab you will learn how to save images to your PC using the Buffering and Transfer 
menu.  You will also learn how to use the Auto no-read image saving functionality. 
 

Follow the steps below to complete this lab exercise: 
 

1. Connect your DataMan reader to the DataMan Setup Tool.  

2. Click the Reset Configuration button from the System Menu. 
 

 
 

 The Configuration reset dialog box displays. 
 

 
 

 

3. Click the OK  button to continue. 
4. Navigate to the Application Details step and set the following Trigger Settings 

parameters: 

• Trigger Type = Burst 

• Interval (µs) = 1,000,000 (1s) 

• Burst Length = 5 
 

    
 

5. Return to the Optimize Image step – open the Tune menu and use the Optimize 
Brightness and Optimize Focus settings to ensure that you can read the Ace of 
Clubs. 
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6. Open the Settings menu and click the Buffering and Transfer button. 
 

 
 

 The Buffering and Transfer page displays.  
 

 
 

7. Scroll down to the Buffered Image Settings and notice that the Size is set to Full 
and the Format is set to Bitmap. 

 NOTE: These are required settings to re-process an image. 
 

 
 

8. Click the Image PC Transfer tab and create a folder to store images on your PC. 
 

 
 

9. Click the Image Buffering tab and set the following settings: 

• What Results to Buffer = Read 

• What Images to Buffer for a Result = All 
Leave all other settings as the Defaults. 

 

 
 

10. Trigger the reader and put the barcode in the FOV so that it can be read on the 3rd 
image. 

 NOTE: Since we did not define a multi-code scenario, the reader will stop acquiring 
when the code is read. So, after 3 images, the reader stops acquiring. 
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11. Click on the Image PC Transfer tab – notice that the Number of Buffered Images 
is 1. This is because we told it to buffer ALL Images for a Result. 

12. Click the Transfer Now button.  
 

 
 

13. Click the Open in Image Playback button. A new tab opens. 
 

 
 

 An Image Playback tab opens. 
 

 
 

 We can see all 3 images that were taken until the code was read in the filmstrip. 
 

 
 

14. Return to the Reader tab and click the Clear Transfer Folder button.  
 

 
 
 

1 
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15. Click the Yes button to delete all files from the specified folder.  
 

 
 

16. Trigger your reader while covering part of the barcode so that it cannot be read and 
move it through the FOV. 

17. After the 5 images have been acquired, look in the Image PC Transfer tab. 

• Are there any Buffered Images? 
o No – because the What Results to Buffer field is set to Read and 

there were no images read in this trigger cycle 
 

 
 

18. Click on the Image Buffering tab and change the What Results to Buffer to No 
Read and repeat step 16. 

 

 
 

19. After the 5 images have been acquired, look in the Image PC Transfer tab. 

• Are there any Buffered Images? 
o Yes – you should now see 5 because the What Results to Buffer field 

is set to No Read and there were 5 no read images in this trigger 
cycle. 

 

 
 

20. Click the Transfer Now button.  
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21. Click the Open in Image Playback button. Notice that the 5 No Read images are 
now visible. 

 

 
 

22. Return to the Reader tab and click the Clear Transfer Folder button.  
 

 
 

23. Click the Yes button to delete all files from the specified folder.  
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Backup  
 

Follow the steps below to complete this lab exercise: 
 

1. Click the Home tab.  
 

 
 

2. Click the Backup function.  
 

 
3. Select the Reader (or Readers) to backup.  

 

 
 

4. Click the Backup button in the lower right-hand corner.  
 

 
 

 The Backup is run. 
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5. Click the Close  button.  
 

NOTE: This creates a folder on the C: drive with the Reader Name and places a 
.dmb file into the folder. 

 

 
 

 
NOTE: The Location for the DataMan backup can be updated under the Home tab in 
the Options menu. 
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Restore 
 

**Please read through the steps, but do not complete the Restore of your reader.** 
 

1. Click the Home tab.  
 

 
 

2. Click the Restore function.  
 

 
 

3. The Configuration Source displays. Click the Latest Backup radio button.  
 

 
 

4. Click the down arrow on the Restore button and click Restore with network 
settings.  

 

 
 

 This will start a system reboot. 
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Compare Configurations of Multiple Readers 
 

Follow the steps below to complete this lab exercise: 
 

 NOTE: You must have at least two readers to compare configurations. 

1. Click the Home tab.  
 

 
 

2. Click the Connect function.  
 

 
 

3. Verify or Connect to a reader (this will be used as the reference Reader). 

4. Click the Compare Configurations button in the lower right-hand corner.  
 

 
 

 The Compare Configurations 1 tab opens.  
 

 
 

5. Click the Add Device button. 
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6. Select a Reader from the list and click the Add  button.  
 

 
 

 The readers display to allow a side by side comparison. 

 NOTE: The filter is set to Difference to Reference, so the differences are 
highlighted in blue on the 2nd reader so you can see at a quick glance what is 
different.  
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Update Firmware  
 

**Please read through the steps, but do not update the firmware on your reader.** 
 

1. Download, install and launch the latest compatible version of the DataMan Setup 
tool on your PC.  

2. Connect to your reader.  

 
NOTE: When updating a handheld reader it is important that the reader is updated 
first and then the base.  Make sure the reader and base are on the same firmware. 

3. Click the System tab and click the Update Firmware link. 
 

 
 

 The Do you want to apply your new settings to non-volatile memory? displays.  

4. Click the No button. 

5. The firmware dialog displays, highlight the latest version and click the Open 

 button.  
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 The Current Firmware Version dialog displays.  
 

   
 

 

6. Click the Yes  button. 

 The system will update the firmware. 
 

 
 

 

7. Click the Close  button. 
 

 

6.1.1_sr1 
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FTP with DataMan – If time allows  
 

**NOTE: To complete this lab you may need to turn off your WiFi and/or pause firewalls.** 
 

All Ethernet-enabled DataMan readers support FTP. This allows you to send images to a 
remote server so customers can understand why their codes did not read.  
 

We can use the FTP server built into In-Sight Explorer to demonstrate the FTP capabilities.  
 

Follow the steps below to complete the lab exercise: 
 

1. Connect your DataMan reader to the DataMan Setup Tool via Ethernet.  

2. Click the Reset Configuration button from the System Menu. 
 

 
 

 The Configuration reset dialog box displays. 
 

 
 

 

3. Click the OK  button to continue. 

4. Open the Settings menu and click the Buffering and Transfer button. 
 

 
 

 The Buffering and Transfer page displays.  

5. Remain on the Image Buffering tab and change the What Results to Buffer 
setting to All.  Allow all other settings to remain as the defaults. 
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6. Click the Image FTP Transfer tab and set the following Image FTP Transfer 
settings: 

• Server Address – static IP Address of YOUR PC 

• Username – admin  

• Password – leave empty  
 

 
 

7. In the File Name Generation Method section of the Image FTP Transfer tab 
change the File Name to something that identifies your reader (such as the reader 
model). 

 

 
 

8. In the Image Data section of the Image FTP Transfer tab change the Transfer 
Mode to FTP - Runtime. 

 

 
 

9. Open the FTP folder – C:\ ProgramData\Cognex\In-Sight\Emulators\5.6.1. 

 Note: Your FTP path may be slightly different depending on your In-Sight Explorer 
version. 

10. Trigger your reader.  
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NOTE: You likely will get No results. This is because you need to turn on the 
emulator by starting In-Sight Explorer. Open and minimize In-Sight Explorer. No 
need to connect to a sensor. 

11. Give it a few seconds to start up and you will see the image from the previous 
trigger get transferred automatically. Trigger the reader again to send additional 
images.  

 
NOTE: The BMP images are fully capable of being dragged back into the Setup Tool 
to verify a read.  

12. Return to the Image Buffering tab and change the What Results to Buffer setting 
to No Read. 

 

 
 

13. Trigger your reader and block part of the code until you get a No Read.  
 

 
 

 You can also send the results that were read via FTP.  

14. Click on the Result FTP Transfer tab. Enter the Server Address and Username 
as you did for the Image FTP Transfer fields.  
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15. Check the Enable Result Transfer via FTP checkbox.  
 

 
 

16. Trigger some reads on different barcodes and open the result.txt file to view the 
results. 
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Lab Exercise 7.1 – Troubleshooting  
 

At the end of this lab exercise, Participants will be able to: 

• Troubleshoot a variety of issues that will be wrong with the system 
 
The Participant will utilize the following DataMan Functions to successfully complete this 
exercise: 

• DataMan Actions 

• DataMan Settings  

• DataMan System 
 
 
Follow the steps below to complete the lab exercise:  

 
 NOTE: The system should be backed up on a user accessible computer or laptop.   

  

1. The Instructor will ask you to leave the classroom.  When you return to the room 
you will need to troubleshoot any issues with your system and successfully read a 
code .   

  

 NOTE: You should not have to adjust anything in your program.  The changes will be 
environmental.  Make the environment adjust to your program, not the program to fit 
the environment.  

  

2. Once you have successfully finished troubleshooting your system, please assist 
others in need.   
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Lab Exercise 8.1 – Determine Correct Optics  
 

At the end of this lab exercise, Participants will be able to: 

• Use the Optics Advisor and Charts to determine the correct optics for your 
application that will use a DataMan Reader.  

 
The Participant will utilize the following DataMan Functions to successfully complete this 
exercise: 

• Lens Advisor Software 

• DataMan Optics Charts 
 

 
Getting the Correct Optics 
 

1. Collect the following information and record the: 

 a. Working Distance (WD) 

 b. Field of View (FOV) 

 If known: 

 c. Size of Code 

 d. Focal Length  

2. Use the Lens Advisor Calculator to determine the Lens needed to achieve an in 
focus image for the DataMan using a C-mount lens. 

 NOTE: The calculator is located in the Optics Lab Folder or on the Cognex web 
site at: http://www.cognex.com/ExploreLearn/UsefulTools/LensAdvisor/ 

 a. FOV- 100 X 200 mm   WD- 300 mm 

  32 mm F/2 
 6 mm Lens F/1.4 
 16 mm Lens F/5.6 

 b. FOV- 10 X 20 mm  WD-300 mm 

  150 mm F/4 
 50 mm Lens F/2.3 
 16 mm Lens F/1.4 

 c. FOV- 10 X 20 mm   WD- 100 mm 

  75 mm F/8 
 25 mm Lens F/1.4 
 50 mm F/ 5.6 
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Thought Question: 
 What would you expect the Focal length to be if we reduced the working distance 

to 50mm for the FOV of 10 X 20 mm? 
  

3. Use the DataMan Optics Chart to determine the Lens needed to achieve an in 
focus image for the DataMan using a Liquid Lens: 

 NOTE: The Charts are found at the end of this lab or in the class lecture PPTs. 

 a. FOV- 40 X 60 mm  WD-300 mm Code Size  20 mil 2D 

  Liquid Lens 18.8 mm 
 Liquid Lens 13.3 mm 

 b. FOV- 40 X 60 mm  WD-100 mm  Code Size 10 mil 2D 

  Liquid Lens 18.8 mm 
 Liquid Lens 13.3 mm 

 c. FOV- 40 X 60 mm  WD-140 mm  Code Size  10 mil 1D 

  Liquid Lens 13.3 mm 
 Liquid Lens 18.8mm 

 

Thought Question: 
 Could you use a C-Mount instead of a Liquid Lens, what are the advantages of 

using a liquid lens? 
  

If Time Permits: 
 Use the Specific Optics information in each exercise above to determine the Lens 

needed to achieve an in focus image for the DataMan 100/200 but use the 
DataMan 100/200 charts found in the appendix of the class lecture PPTs.  
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Optics Chart for Liquid Lens 18.8 mm – use for objects that are far away 
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Optics Chart for Liquid Lens 13.3 mm – use for objects that are near 

 
 
 
 
 
 
 
 
 
 
 
 
 

 


